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Components

What are components?

We have used the phrase, components, as a way to define all of the features that come with the
Hub platform. We consider all of these elements of the larger whole of the platform. Each
component focuses on a specific task that allows users to submit content. As an administrator, it
is up to you to set up all of the Hub's components to fit the needs of the community.
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Answers

What is the Answers component?

Answers, or Questions and Answers in the front end, is a place to exchange knowledge
about things that are not found in the Knowledge Base. Ask a question that's relevant to your
community or help other users by providing an answer to their questions.

Note: You must be logged in on the backend in order to perform the tasks below.

 

Deleting an Answer

1. In the backend, navigate to Answers under the Components tab
2. Go to the Answers tab and find the answer to be deleted
3. Click on the check box for the answer to select it
4. Click the Delete button symbolized by a trash can

The answer will be fully deleted
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Submitting a Question

1. In the backend, navigate to Answers under the Components tab
2. While on the Questions tab, click the New button symbolized by a plus sign
3. Fill in the details of the question being submitted. Check the box for Anonymous to

remove your name from the question. Select the Notify of responses box to get
emailed about new responses to the question. Fill in the title and the description of the
question. Add tags to the question using the tag box

4. Click Save & Close to save the new question to the hub
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Projects

Enabling Plug-in to Projects

1. Login to the backend of the Hub and click on the Extensions tab
2. Click on the Plug-in Manager under the Extensions tab
3. Search Projects- Databases in the search field to locate the Data Store plug-in
4. After locating the correct plug-in, check the box beside the Plug-in Name
5. Click the Enabled button to allow the plug-in to be used on the frontend of the Hub

If the Menu Item for Databases does not display, the MySQL Configuration may not be correct
for DataViewer.

Restricting Plug-in to Specific Projects

1. Login to the backend of the Hub and click on the Extensions tab
2. Click on the Plug-in Manager under the Extensions tab
3. Search Projects- Databases in the search field to locate the Data Store plug-in
4. After locating the correct plug-in, click on the title of the plug-in under the Plug-in

Name column
5. Inside the plug-in details, type in the names of the Projects in the Restricted to

projects field
6. Save the changes by click the Save & Close button

Uploading Large Files Using SFTP Clients

Create a Local Password

1. If you use a non-Hub related account, then you must first create a local password
2. Login to the HUB
3. On the Dashboard, click Account on the left menu
4. Under Local Password, type in the password in the New Password and Confirm

password text boxes
5. Click Save

 

Setup SFTP Client

1. Download an SFTP client like Cyberduck or Filezila
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2. Add a new site by either clicking the Plus sign icon (+) or File -> Site Manager ->
New Site

3. Provide the following information
a. Host: hubname.org
b. Protocol: Change to SFTP
c. User: Provide the same username used to login to the Hub

4. Click Connect
5. When prompted for password, provide the local password that was created above
6. Once connected, open up the Data file and then the Projects file and double click on

the project that you would like to upload the files to
7. Drag and drop the files into this folder and then check inside of the site and confirm that

these files are uploaded to the right project

Enable Grant Collection Information

If you are working on a Hub that will be creating projects based on grants, then you can enable
a new step to be added in the Project creation to collect grant information. By collecting grant
information for grant funded projects, project quotas can be increase based on the project
budget and this information can help support annual reviews of the Hub. To enable this feature,
follow these steps:

1. Navigate to the backend of the Hub 
2. Hover over Components and from the drop-down click Projects
3. Click the Options button in the upper right corner of the screen
4. Inside of Options, click the Setup tab
5. Find the Collect grant info at Setup and change the drop-down to Yes
6. Click Save & Close 
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Project File Connectors

Project File Connectors

HUBzero allows for files to be shared either on a repository owned by the Hub or connect to
other file management platforms. Project File Connectors allow for these third-party file
management systems to enable files uploaded on the Hub yet stored in their system. Follow
these instructions to set-up and provide Project File Connectors to your users:

1. Navigate to the third party file management system of your choosing, such as Google
Drive or Dropbox

2. Set-up either a new project or application and fill in information about the Hub in order to
obtain an API key and API secret upon saving

3. Make sure you set the callback address to your Hub and indicate the appropriate file
system

1. Example: When setting up a Google Drive API connector to redirect to YourHub,
the following callback should be used
- https://yourhub.org/developer/callback/googledriveAuthorize

4. Once the API key and API secret have been created successfully, navigate back to
the /administrator interface and login

5. Hover over Extensions and select from the dropdown Plug-in Manager
6. Search or locate the appropriate plugin connected to the file system

1. Example: If the file system chosen is Google Drive, one would select
the Filesystem - Google Drive plugin

7. Click on the title of the plugin and change the status to Enabled
8. Insert the API Key in the Client ID and the API Secret in the Client Secret
9. Fill in an further information as necessary then click Save & Close

10. While still at the Plug-in Manager, search for and click the Projects - Files plugin.
11. Scroll down until you see an option for Default Action, and set it to Connections (view

available connections).
12. Navigate to a Project you would like to setup a new file system

1. Note: You must be a manager of the Project in order for you to set-up the File
System

13. Click on Files and then click on New Connection and choose the file system from the
dropdown

14. Choose to bypass the secondary step of connecting to the same API..... 

Setting up an External Application (Dropbox, Google Drive, AWS S3)

For using external services via OAuth2 the Hub needs a client identifier and secret for use with
that service.  The methods of obtaining these values vary from service to service and are
subject to change at the provider's discretion.  Below are the instructions for setting up a
developer application on some services (adapting the instructions with some searching should
yield similar results for other services or services that have changed their process in the future).
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[Creating an application on Dropbox]

1. Navigate to https://www.dropbox.com/developers
2. Sign in using the Dropbox credentials that you would like your Hub (the server itself) to

authenticate against, this is usually an account owned by the group or organization.
3. On the left menu, click "My Apps".
4. On the top right, click "Create App".
5. Select the access level you would like to grant your Hub to your users Dropbox

accounts.
6. Give the application a name (this name will be displayed to users when they authorize

access to their Dropbox account).
7. Read and agree (or disagree) to Dropbox's terms.
8. Click "Enable additional users".
9. In the redirect URIs section, add the URI of

"https://<yourhub.org>/developer/callback/dropboxAuthorize".
10. At this point you should save the "App key" and show and save your "App secret", you

will need to input these on cdmHUB in a later step.
11. You can now click on the branding tab and brand the application to your Hub's needs

(adding icons, links to the website, etc.).  These are all used when a user is asked to
enter their Dropbox credentials on behalf of your Hub.

Dropbox currently limits development accounts to 500 users per id/key, this can be
raised by contacting Dropbox support and applying for a production key once that limit
has been reached.

 

[Creating an application on Dropbox]

1. Log in to your Google account and go to the APIs & services
2. Navigate to "Credentials" using the left-hand menu 
3. On the "Credentials" page, click "Create credentials" and choose "OAuth client ID"
4. Create "New Credentials"
5. On the "Create client id" page, select "Web application". In the new fields that display,

set the following parameters:
1. Field:   Description
2. Name:    The name of your web app
3. Authorized JavaScript origins:   

1. https://yourhub.org
4. Authorized redirect URIs:       

1. https://yourhub.org/projects/auth  
2. https://yourhub.org/developer/callback/googledriveAuthorize

5. Web App Credentials: Configuration
6. Click "Create" to proceed

1. Your "Client Id" and "Client Secret" will be displayed
7. Save your Client Id and Client Secret to enter into the Connection settings into
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"Filesystems - Google Drive" plugin
1. Additional documentation can be found here: 

1. https://cloud.google.com/docs/authentication/api-keys
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Publications

Minting DOI's through DataCite (previously EZID)

DOI (digital object identifier) service is available on the HUBzero platform through integration
with DataCite, an international member organization that provides persistent identifiers for data
and other scholarly resources. For Purdue, this service is managed locally by the Purdue
Libraries. To inquire, contact them at datacite@purdue.edu.

Curation Workflow

Turning on Curation:

1. From the backend, navigate to Components -> Publications
2. Click the Options button
3. Click the Curation tab
4. Select ON in the Curation field
5. In the Name of Group of curators field, type in the CN of the group you want to give

curation rights to
6. Optionally, select 1 month in the Grace period for changes box if needing to give users

the ability to change the publication after it has been published
1. Note: mkAPI will not run until the one month grace period if set.  

7. Click Save & Close to ensure the changes and are submitted
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Auto-Approve Publications

If you would like certain users to have their new Publications by pass the Curation steps, you
can add them to a list where their Publications are auto-approved. To add users to this list,
follow these steps:

1. Navigate to the backend of the HUB and click on Publications underneath the 
Components drop-down

2. Inside of Publications, click on the Options button
3. Click on the Curation tab and then insert the usernames of the users who's Publications

are to be auto-approved
4. Click Save & Close to save the changes

Enabling Databases

To enable databases within Publications:

1. Log onto the administrative backend
2. Go to Components
3. Go to Publications
4. Go to Master Types submenu item
5. Select the checkbox next to the Database table row
6. Click the Edit Button
7. Find the Content block for the Databases Type
8. Click the [Edit] button next to Block Elements
9. Locate the Type drop-down, change file to data

10. Change the Maximum count to 1
11. Save the Block Element

 

 

Creating a Publication License

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Licenses tab and then click the New button in the upper right hand corner
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of the page
3. Start filling out the License Information:

a. Title: The title of the license
b. Name: The name of the license, full name if the license is an acronym
c. URL: The webpage that all the legal license information
d. About: The background information about this license
e. Content: The parameters of the license such as what content this license

supports
f. Icon: Path to icon image that lives in the Media Manger on the HUB

4. Once you have filled out the License Information, begin filling out the License
Configuration:

a. Active: If this license should be automatically published and available on the
frontend for users to use after saving

b. Customizable: Should the license text be customizable for publication authors
to edit

c. Agreement required: Forces publication authors to
5. Once you have finished filling out the information for the license, click Save & Close

Selecting a Default Publication License

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Licenses tab and locate the Default column
3. Locate the license that should become the new default and select the box beside the

license title
4. Click the Make Default button (star icon) and the license will be made the new default

Publishing/Unpublishing a Publication License

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Licenses tab and locate the license you want to publish or unpublish
3. In the Status column you can click on the check-mark or cancel sign to change the

status of the license
4. After clicking on the status icon the new status will be automatically saved

Reordering Publication Licenses
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1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Licenses tab and locate the Order column
3. Rearrange the licenses by clicking the arrows facing up and down
4. The final ordering you leave the licenses in will appear the same inside of Publications

on the frontend of the Hub inside the License drop-down when creating a new
publication

Creating Publication Categories

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Categories tab and then click the New button
3. Begin filling out the Category Information:

a. Name: The name of the new category
b. Alias: The shortname of the new category
c. URL Alias: The URL name for the category
d. dc:type: The Dublin Core Meta Data type
e. About: A short introduction describing what type of publication files and content

are stored in this category
4. Determine what plugins you want to connect to the this new Publication Category
5. Fill out the Item Configuration:

a. Status: Determine if the category is active (publish) or inactive (unpublished)
b. Contributable: Determine if the category can be contributed to

6. Determine the Custom Fields by creating new fields or managing the preexisting files.
The fields determine the layout of the Publication overview page:

a. Reorder: Drag and drop the different field rows to change the order
b. Field name: Change the name of the field title
c. Input Type: Determine the amount of text that can be inputted in this field from

the drop-down
d. Required: Check the box to make the field required for the publication author to

fill out before publishing the publication
7. Review the information and then click Save & Close

Publishing/Unpublishing a Publication Category

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Categories tab and locate the license you want to publish or unpublish
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3. In the Status column you can click on the check-mark or cancel sign to change the
status of the license

4. After clicking on the status icon the new status will be automatically saved

 

Handling Publication Options

1. Navigate to the backend of the Hub and click on Components and from the drop-down click
on Publications

2. Open up the Publications tab and then click the Options button in the upper right hand corner of the
page

3. Inside the Publication Options, the different areas of Publications can be managed and adjusted as
needed:

4. Defaults:
1. Component ON/OFF: Turning on or off Publications
2. User Contributaions Outside of Projects: Allow users to contribute to Publications outside

of Projects
3. Email Notifications: Allow component to send out emails
4. Default Category: Newly created Publications will automatically be defaulted to this category

if not selected by the publication author
5. Default Publication Thumbnail: Path to default publication, used as a placeholder
6. Default Video Thumbnail: Path to default video, used as a placeholder
7. Default Image Thumbnail: Path to default image, used as a placeholder
8. Default Master Image: Default image for Publication page cover, used as a placeholder
9. Publication Files: Master path for restoring published data

10. URL to Documentation: URL to page with Publication information
11. URL to Terms of Deposit: URL of Terms of Deposit page on the HUB

5. Curation:
1. Name of Curators:(Hub) group members authorized to perform pre-publication curation (all

publication types) and manage curation assignment
2. Grace Period for Changes:Allow authors to make changes to a published resource within

the grace period after approval
3. Auto-approve:Automatically approve new submissions
4. Auto-approved Users:A comma-separated list of usernames to be auto-approved

3. DOI Configuration:
1. About DOI Link: a link to an explanation of what Digital Object Identifiers (DOI) are [optional]
2. DOI Namespace Start: First part of DOI namespace (what goes right after DOI: and before

/,e.g. 10.5072)
3. DOI Namespace End: Hub-specific DOI namespace end (usually 2-3 characters going after

/, e.g. F2K
4. DOI Service URL: DOI service address
5. DOI Service User/Password: DOI Service/Password
6. DOI Publisher: Publisher name (may use full HUB name) for DOI service
7. DOI Resolve URL: URL for resolving DOI's
8. DOI Verification URL: URL for verifying DOI's
9. Issue master DOI for Publication?: Master DOI links to /main page listing all previously
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published versions
4. Sections:

1. Contributors: Show/Hide the list of authors on publication page
2. Format Author Display: Format list of authors on publication page
3. Ranking: Show/Hide the ranking
4. Rating: Show/Hide the rating
5. Date: Show/Hide the date on the publication page
6. Linked Data: Show/Hide a link to an OAI-ORE compliant linked data representation in the

HTML source for each publications
7. Citation: Show example/instructions for citing this publications.
8. Suggest License: Allow users to suggest licenses
9. Citation Format: Choose format for citations

10. Supported Tag: A tag to display to indicate Org supported tools
11. Supported Link: A link display to describe Org supported tools
12. Audience Link: URL to a page describing audience levels.

5. AIP:
1. Trusted Digital Repository: Trusted Digital Repository
2. AIP Path: AIP path (for trusted digital repos)
3. MkAIP Admin Group: Group of administrators to get notification about archived dataset

Master Types: Editing Block Information

1. Navigate to the backend of the HUB and click on the tab Components
2. From the drop-down click on Publications
3. Inside of Publications, click on the tab Master Types
4. Click on the name of the Master Type that you want to edit block information in
5. Locate the Block you wish to edit

1. A Block is a section of the Publication that holds information about the materials
being published (i.e. description, abstract, etc.)

6. Find the Block Elements section and click the Edit in brackets 
7. Change the block information as fit, for example below is a use case of a small issue

that occurs in some Master Types with the abstract switching with the description:
1. In this case the abstract and description mappings are incorrect. There is a

section that tells the block which field the Publication versions table what to map
from the content block. Here, one would switch the description alias and name
from abstract to description and vise versa. 

8. Click Save & Close to save these changes

Setting Up Group Association with a Publication

Groups can be associated with a Publication that was not published from a Project owned by
any groups. Only one group can be given association rights. Usually a group is associated with
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a Publication if the group contributed materials or resources that helped with the Publication's
development or if the group helped fund this Publication. To set up the ability for users to
associate groups with their Publications, follow these steps:

1. Navigate to the backend of the Hub
2. Hover over Components and click Publications from the drop-down
3. Inside of Publications click the Master Types tab
4. Click the title of the Master Type that you want this feature to be enabled on
5. Under the section called Blocks and Configuration locate the Authors block
6. Locate the Show group ownership and allow to be assign group ownership and change

the drop-down to be Yes
7. Click Save & Close and this feature will be enabled on this Master Type 
8. Enable this on each Master Type that you wish for this feature to be enabled

Can attaching a license to a Publication be made optional?

Yes, it can be set up in specific Master Types:

1. Navigate to the backend of the Hub
2. Hover over Components and select Publications from the drop-down
3. Select Master Types tab
4. Select the Master Type you would like to manage this setting
5. Inside the Master Type locate the License block and change "Input required" to No
6. Click Save & Close

Setting up minting DOIs as optional for a Publication

It can be set up in specific Master Types:

1. Navigate to the backend of the Hub
2. Hover over Components and select Publications from the drop-down
3. Select Master Types tab
4. Select the Master Type you would like to manage this setting
5. Inside the Master Type locate the Curation Configuration block and change "Require

DOI" to Offer choice to publish with DOI or post without DOI
6. Click Save & Close
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Batch Create

1. Navigate to administrator on the Hub
2. Hover over Components and select Publications from the drop-down
3. Select Batch Create tab
4. Select a project you would like to create publications in
5. Underneath Data, click Choose File and upload a .xml file with the publications.
6. Make sure the .xml file follows the schema provided by the link on your hub

7. Click Process data and review the record to add to the database as there may be
errors.

8. After verifying the data is correct, click the Create record(s) button
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DataCite

 DataCite MDS API Application

The DataCite Metadata Store (MDS) API[1] is going to be used for Hub dataset Digital Identifier
Object (DOI) and corresponding metadata creation and update.

1. Introduction 

The DataCite Metadata Store (MDS) API is the default API for registering DataCite DOIs and
associated metadata. Below shows the requirements for using the MDS API. 

(1) The API requires authentication. If your hub or university is member of DataCite and has
DataCite credentials then you can configure DataCite to mint DOIs for your hub's publications
and tools. DataCite also has a testing guide to help with troubleshooting.

(2) DataCite assigns the DOI prefix. 

(3) DOI request needs to transfer through HTTPS. 

(4) HTTP basic authentication is performed in the DataCite Metadata Store API usage. 

 

2. DOI register 

The DOI registration takes two steps, first is to register DOI metadata, and second is to register
the DOI name and dataset URL. 

 

2.1 Registering DOI metadata 

The DOI metadata for dataset includes title,
author, dates, description, and so on. All the
metadata that a hub collects for a dataset
shows in table 1. Metadata element 

Explanation 

Identifier Identifier type is doi, and the value of identifier
is the doi. 

Creators/creator/creatorName Author(s) of the dataset 
nameIdentifier nameIdentifierScheme is ORCID? and value is

the ORICID. 
titles/title Name of the dataset. 
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publisher Holder of the dataset 
publicationYear The year when the dataset is published 
Contributors/contributor/contributorName Project leader's name 
dates There are two metadata elements, one is when

dataType is Valid, the value is the date when
the dataset is submitted on the hub; Another is
when the datatype is Accepted, the value is the
date when the dataset is approved for publish
on the hub. 

language It is set to en by default 
resourceType resourceTypeGeneral is set to the

resourceType designated by the hub. The value
is the resourceTypeTitle. 

RelatedIdentifiers/relatedIdentifier relatedIdentifierType is DOI, relationType is
IsNewVersionOf, and the value is the
relatedDoi, which is DOI of the resource that
reference this dataset. 

version Publication version 
rights The license that user selects in the dataset

submission workflow on the hub 
Descriptions/description DescriptionType is Abstract, and the value is

the abstract of the dataset 

 

The metadata elements in table 1 are saved in xml format as showing below. 

<resource xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns="http://datacite.org/schema/kernel-4"
xsi:schemaLocation="http://datacite.org/schema/kernel-4
http://schema.datacite.org/meta/kernel-4.1/metadata.xsd"> 

<identifier identifierType="DOI">doi</identifier> 

<creators> 

<creator> 

<creatorName>name 1</creatorName> 

</creator> 

<creator> 

<creatorName>name 2</creatorName> 

                            18 / 94



COMPONENTS
 

</creator> 

<creator> 

<creatorName>name 3</creatorName> 

</creator> 

<creator> 

<creatorName>name 4</creatorName> 

<nameIdentifier nameIdentifierScheme="ORCID">orcid goes here</nameIdentifier> 

</creator> 

</creators> 

<titles> 

<title>title</title> 

</titles> 

<publisher>YOUR HUB's NAME</publisher> 

<publicationYear>year</publicationYear> 

<contributors> 

<contributor contributorType="ProjectLeader"> 

<contributorName>name</contributorName> 

</contributor> 

</contributors> 

<dates> 

<date dateType="Valid">date</date> 

<date dateType="Accepted">date</date> 

</dates> 
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<language>en</language> 

<resourceType resourceTypeGeneral="Dataset">Datasets</resourceType> 

<version>1.0</version> 

<rights>Attribution 3.0 Unporte</rights> 

<descriptions> 

<description descriptionType="Abstract"> 

Description goes here 

</description> 

</descriptions> 

</resource> 

All the metadata elements conform to the DataCite metadata schema [2] standards. 

The MDS API can generate random DOI name when prefix is included in the metadata
registration. The identifier in the metadata xml can be left empty in this case. 

The curl package can be used to submit the metadata to MDS service, see example below.
Note that the [PREFIX] would need to be replaced with your hub's DataCite prefix. 

curl -H "Content-Type:application/xml;charset=UTF-8" -X PUT -i --user username:password -d
@[PREFIX].xml https://mds.test.datacite.org/metadata/10.5072 

The response to the call above is OK ([PREFIX]/XXXX-XXXX). We need take the DOI out from
there and use for further process. 

The identifier value in the metadata xml on DataCite will be replaced by the DOI name that is
created in this step. 

The DOI is set to Draft state [3] after the metadata are registered. 

 

1.2.2 Registering the URL 

The second step is to register the DOI name and the URL that refers to the dataset. Below is an
example of the curl command. Note that DOI name and URL to the dataset is included. 
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curl -H "Content-Type:text/plain;charset=UTF-8" -X PUT --user username:password -d
$'doi=[PREFIX]/0000-03VCnurl=http://example.org/publications/1'
https://mds.test.datacite.org/doi/10.5072/0000-03VC 

The DOI transits from Draft state to Findable state after the DOI name and URL is registered. 

Below table includes the endpoint and other
useful information that need to use in the DOI
registration in production. The endpoint, prefix,
username and password need to be configured
on the admin interface for any development and
production environments. 

Value 

DOI prefix [PREFIX]
MDS production endpoint https://mds.datacite.org 

 

2. Update DOI Metadata Records 

Update the DOI metadata is the same as storing a new version of the DOI metadata. According
to the MDS API document, we need to issue a post of the metadata xml to DataCite. Below is
an example on what the curl command should look like for such operation. 

$ curl -H "Content-Type: application/xml;charset=UTF-8" -X POST -i --user username:password
-d @[PREFIX]/JQX3-61AT.xml https://mds.test.datacite.org/metadata 

 

Reference list 

1. https://support.datacite.org/docs/mds-api-guide 

2. http://schema.datacite.org/ 

3. https://support.datacite.org/docs/doi-states 

4. https://support.datacite.org/docs/testing-guide

 

 

 

Switching from EZID to DataCite
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1. Navigate to /administrator and login to the backend of the Hub
2. Click on Components and then select Publications
3. Click on Options and then click on DOI Configuration

1. Note: You will only be able to access the Options button if you are a super user.
4. Locate Enable DataCite or EZID DOI Service and select from the drop-down the

appropriate option
1. Note: When the "DataCite" is selected, the DataCite DOI service is activated and

only DataCite related options on the configuration form are going to show up.
When "EZID" is selected, EZID DOI service is activated and only EZID related
options on the configuration form are going to show up. When "None" is
selected, all options related to DOI service will be hidden. When users publish a
dataset in this case, a message saying that "No DOI service is selected and
please contact site administrator" is popping up.

5. Click Save & Close
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Resources

Creating a Resource

1. Log in to the backend of the Hub, hover over the Components tab and click Resources
2. Click New to create a new Resource
3. In Details insert the following details about the Resource

a. Title: This is the name of the Resource that users will see.
b. Type: The type is the classification of the Resource.
c. Alias: The title of the Resource that is used in the URL.
d. Location: The place where the Resource can be found.
e. Time: This is the creation date of the Resource.
f. Canonical: A separate URL can be added to the Resource to connect a

separate URL or link to the Resource.
g. Intro Text: This is the basic information of the Resource or the abstract of the

Resource.
h. Main Text: This is the main section of the Resource information.

4. In Contributors insert the authors of the Resource by inputting their User ID, name, or
username and click Add

a. Removing an Author: Click the trashcan beside the user’s name or Delete icon
to remove the user as an author on the Resource.

b. Changing the Affiliation: Click in the Affiliation text box and type in a new
affiliation or title that labels how this user is affiliated with the project, for example
Researcher.

5. In Publishing insert the following details about the state of publishing for the Resource
a. Standalone: Check the box to make the Resource easier to find or uncheck the

box to disable that access.
b. Status: This is the state of the Resource and it’s availability to the Hub.

i.Draft (user created): The Resource is in the process of being created by a user.

ii.Draft (internal): The Resource is in the process of being created by an administrator on the
back-end of the Hub.

iii.Pending: The Resource is waiting for approval by an administrator of the Hub.

iv.Unpublished: The Resource is not available to the front of the Hub.

v.Published: The Resource is available to the front of the Hub.

vi.Deleted: The Resource has been deleted from the front of the Hub.

c. Group: Select a group on the Hub to add the resource to the group.
d. Access Level: This determines what users can access the Resource.
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i.Public: The Resource is available to all users of the Hub and visitors of the Hub.

ii.Registered: Only registered users of the Hub can access the Resource.

iii.Special: Only administrators can view the Resource.

iv.Protected: The Resource’s abstract can be viewed, but only group members can access the
files. A group must own the Resource

v.Private: The Resource is only visible to group members. A group must own the Resource.

e. Change Creator: The drop-down can be used to change the creator to another user of
the Hub or administrator.

f. Start Publishing: The date that the Resource was published on the Hub.
g. Finish Publishing: The date that the Resource was unpublished from the Hub.
h. Hits: This is a number totaling all of the times a user has read to used a resource.

6. In Files upload the files for the Resource
a. Uploading a File: Add a file to the Resource by selecting a file and uploading it

to the Resource by clicking Upload.
b. Changing the File’s State: Select the file and use the drop-down to change the

visibility of the file by clicking Apply. For example, this allows images added to a
Resource the ability to open as an image instead of a download.

c. Create a Directory: This can create a file to add to the Resource by adding the
title of the directory in the text box.

7. In Tags type in words that affiliate the Resource with labels or titles. These tags can
connect the Resource with other parts of the Hub or words that can make searches on
the Hub easier to locate this Resource

8. In Parameters select the restrictions that can be set on this Resource to limit what is
visible, so parts of the Resource that are not filled out can be hidden from users

a. License: To connect this Resource with a license, type the license in the
provided text box.

9. Review the Resource, then click Save & Close

 

Editing a Resource

1. Log in to the backend of the Hub, hover over the Components tab and click on 
Resources

2. Locate the Resource, and check the box of the resource to select it
3. Click Edit to edit the content of the Resource
4. Once the content has been edited, click Save & Close
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Deleting a Resource

1. Log in to the backend of the Hub, hover over the Components tab and click Resources
2. Locate the Resource that is to be deleted
3. Select the Resource’s check box, and then click Delete
4. The Resource will be automatically deleted and removed from the Hub permanently

Creating Resource Types

The default list of types may not work for all Resources, thus any Hub administrator can create
a Resource Type. This can be done from the administrative backend of the site by following
these steps:

1. Log in to the backend of the Hub
2. Navigate to the Components tab and then click on Resources
3. Once the Resources Manager page has loaded, select Types from the sub-menu found

under the Resources Manager title
4. You should now be presented with a list of all the Main Types (selected by default).

There are multiple categories of types
1. If not already selected, select Main Types from the Categories option found

directly above the list or navigate the listing until you see those designated as 
Main Types. These are the primary types of resources users will be able to
contribute, browse, etc.

5. Click the title of a type to edit it or click New from the toolbar on the top right of the page
6. Fill in the title and alias of the new type
7. Select the category of the new Resource Type from the drop-down

1. Generally it is a best practice to select the Main Types option from the drop-
down if you want to give users easy access to the new Resource Type.

8. Decide if this resource type can be contributable from the frontend
by checking/unchecking the Contributable checkbox

9. Add a description in the Description text box to describe the new Resource Type
10. Decide what custom fields you wish to have filled in by the user for that resource type

1. Field Name: The name of the field where data about the resource is entered.
2. Input type: Options are single-line text boxes, multi-line text areas, checkboxes,

select list (pull down), radio options, pre-defined options (language list, etc.).
3. Required: A field may be required or not. By checking the Required box, this

field must be filled out by the user in order for them to submit the Resource
11. The Custom Fields can be reordered by selecting the multiple lines under Reorder and

dragging up or down depending on the preferred placement of the fields
12. Add a new custom field by clicking the Add new row button under the current fields
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13. Click Save in the toolbar on the top right of the page
14. New resource types should now be available as a resource option and changes to types

should take affect immediately

Creating a Series Resource

A series is a resource type that allows multiple resources to be placed under a parent resource.
This is especially useful for resources that are related and can be viewed together.
Administrators can create these resources on the backend of the Hub.

 

Create the Parent resource:

1. Log in to the backend of the Hub and under the Components tab select Resources
2. In the Resource Manager, create a new resource by clicking the New icon
3. Fill in the new resource details such as the title, location, and text
4. In the type drop down, select Series as the new resource type
5. Select the contributors by entering the user’s name or user ID and then add them to the

list of contributors
6. Fill in the publishing information by selecting the status as Published, the group the

resource will belong to, access level, creator of the resource, and the publishing dates
7. Click Save & Close to save the new resource series

 

Add the Child resources:

1. In the Resource Manager, find the new resource series and click on the + under the
column Children

2. Create a new resource to add under the parent resource or add in previously created
resources by clicking Add existing and typing in the resource ID, then click Next

2. Note: Only add one child resource at a time.
3. After one child has been created, you can continue adding children by clicking Add

Child under the Resource Manager: Child Resource. Repeat the process until you have
completed the series

4. View the new Resource series on the frontend of the Hub
a. On the Resource, click Series and you will be able to view all of the resources

under the parent resource.
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Installation & First Time Configuration

1. A system administrator must install the hubzero-solr RedHat or Debian Package using
a package manager such as yum or aptitude

1. On RedHat: sudo yum install hubzero-solr
2. On Debian: sudo apt-get install hubzero-solr

2. To start the service: sudo service hubzero-solr start OR sudo /etc/init.d/hubzero-
solr start>

3. A Hub administrator may configure the Hubzero CMS to use Solr instead of basic search
by going to Components > Search > Options > Engine > Apache Solr

4. A Hub administrator must further configure the service by clicking the “Solr” tab in the
Search Options. The default parameters will work out-of-the-box for Open Source Hubs.
HUBzero Managed Hubs will use the following port-numbering.

Development: 2090
Stage: 2091
Scan/QA: 2093
Production: 2093

Note: The default configuration should be acceptable. Running Solr on
another host, changing the core, the path, or the log path are at the Hub
Administrator's own risk.

5. Click Save & Close 
6. Return to the Search and you should see a status page like the one below:
7. If this is the first time the Hub has used Solr as its search engine, the index will need to

be filled with current data
1. This is a lengthy operation during the first run
2. Unless there is massive data corruption, this will only need to be performed once
3. To check the progress of the indexing process, you may click on the Index

Queue tab in the Administrative Search interface
8. Once the full index has been built, searching can be completed from the enabled search

interfaces

If there were any issues with configuration, please submit a support ticket and the HUBzero
team will assist you further.
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Maintaining the Index

There should be very little effort needed to maintain the index. Solr maintains the index and the
HUBzero CMS will instruct Solr to add, remove, or update records inside of its index.

Solr saves its index on the filesystem of the server which allows the retention of data if the
server needs to reboot or the Solr process crashes. This prevents having to rebuild the index
from scratch in such events.
 

IMPORTANT NOTE: Due to the large amount of processing power needed to convert database
content into a searchable document and the need to communicate with a system outside of the
CMS, changes to the index WILL NOT be reflected immediately. The queue will be worked on a
first-in-first-out basis. This means that the oldest item in the work queue will be processed first.
The amount of time it takes to perform indexing operations depends on the amount of data
contained on the hub. If there is a large amount of content, the time to perform a full index will
be greater. Once the full index is built, indexing operations should be noticeably quicker
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Plugins

Search plugins allow developers to add support for different component data in the hub. In order
to appear in the search index, the plugin must be enabled. This can be accomplished by going
to the Administrative backend > Plug-in Manager > [Filter by Type: Search] > and ensuring that
the types are enabled. For example Solr will index wiki pages when the “Search Wiki” plugin is
enabled.

The plugin provides some necessary information for indexing and other search-related
operation. By default, the categories in the search interface correspond with these plugins.

System Search Plugins

In order to keep the search index “fresh”, a couple of new system Events have been made that
capture when items using the Relational Class / ORM are created, edited, or deleted. Once the
system event fires, it calls an event in the Search - Index plugin which handles placing the newly-
updated data into the processing queue. A migration has been written to ensure that the System
- Content plugin and the Search - Solr plugin have been enabled. If you notice that the index is
not being refreshed with new content, check that both of these plugins are enabled.
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Blacklist

The blacklist allows Hub administrators to “strike” things from the search index. This may be
necessary to override  If Solr indexes something, it will be reindexed unless it is on the blacklist.

To remove an item from the seach index, go to the Administrative Backend > Component >
Search > Search Index  and Click on the name of the type of record you would like to remove.
Let’s say, for example, you needed to remove a Resource.

1. Click Resource

 

2. You will then see all resources indexed by Solr
3. You may use the search box to locate the record
4. Once you locate the record, click Add to Blacklist 

5. Once the button is pressed, the request to remove the record will be placed into the
queue 

6. Once the worker processes the record, it will no longer be searchable by anyone
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Administration

Restarting Solr

If Solr needs to be restarted, a system administrator can issues the following commands:

1. sudo service hubzero-solr restart
2. sudo /etc/init.d/hubzero-solr restart

Solr Index CRON Updater

In order to keep the Solr index up-to-date, the CMS will periodically call a routine to process the
queue. Although CRON is not the best tool for the job, it will dutifully process the queue every
minute if configured. There are plans to develop a background process which will make this
process more efficient.

To configure the CRON Task, follow these steps:

1. Navigate to /administrator
2. Hover over Components  and click Cron from the drop-down
3. Click Add a New Task and set the "Event:" to Process Queue

4. The New Cron Task should be configured to run every minute
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Breadth

The question is “What can I search for?”. The answer is “anything you have access to
contained within the list in Search Categories. To see all content within these categories
perform a simple query using the wildcard character “*” as shown below.

A better of what is currently inside Solr’s index can be viewed on the administrative backend by
going to Components >> Search >> Search Index Tab. The number of index items is located
next to each type. Clicking on the name of the hub type will perform a search on that type,
displaying all items that are within the index of that type.

For instance, clicking “Resources” shows the following screen:

One can perform additional searching using the “Filter” bar on top of the results listing.
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Boosting

Search boosting allows hub administrators to move categories of matching results higher or
lower in Solr search results.

Note: your hub must have Solr installed and enabled as boosting only affects Solr search
results.

To create a boost follow the steps below:

1. Access your hub's administrator portal
2. Click on Search under the Components drop-down menu
3. Click on the Boosts tab under the component title bar

1.  

4. Click on the plus in the upper right hand corner

1.  

5. Select a category from the Type drop-down

1.  

6. Enter a number for the boost strength
1. Positive value moves matching results higher
2. Negative value moves matching results lower

7. Save the boost

1.  
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Storefront

Overview

There are six main sections that must be completed in order to add a product to the storefront:
products, product options, product skus, collections, option groups, and options.

 

All actions listed here take place in the administrator interface of the hub, similar to 
https://hubname.org/administrator.  Proper administrator privileges and logging in are required.

 

Storefront component can be found by:

1. Log into the administrator interface (/administrator)
2. From the Main Menu point the mouse to Components -> Storefront 

 

                            35 / 94

https://hubname.org/administrator


COMPONENTS
 

 

Some terms that will be helpful:

 

Control buttons:  Always at the top right of a page, but under the logout button.  Typical
actions include: Save, Save and Close, Cancel, New, Edit, etc.

 

Alias:  Refers to the short name of a name or title that appears in the URL.  Does not usually
include numbers or symbols.  For example, a collection entitled Antivirus & Security
Software has an alias of securitysoftware

 

SKU: Stock keeping unit.  Specifies a specific product after options have been selected.  For
example, the product is ArcGIS, and there may be many SKUs available: ArcGIS Trial Windows
10, ArcGIS Pro Windows 10, ArcGIS Pro Mac OS 10.4+, ArcGIS Pro Linus, etc.

Creating a Collection

1. From the Storefront administrator interface , click on the Collections tab
2. From the control buttons at the top right of the page, click on the plus icon button (+) to

add a new collection
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3. Enter a collection Title and alias and select it to be Published

4. From the control buttons click on the star icon to Save and Close

Creating a Option Group

1. Click on the Option Groups tab
2. Click on the control button with the plus icon to create a new Option
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3. Enter a Title and select it to be Published
4. From the control buttons click on the star icon to Save and Close

Creating Options

1. Creating Options
Click on the round plus icon in the Option (Published column) to create a new

option

 Enter a Title and select it to be Published

From the control buttons click on the star icon to Save and Close

Repeat as needed for additional options.

 

Note:Clicking the number in the options column will display the list of all created options that
option group.New option may also be added from that page by clicking on the plus icon control
button.

 

Creating a Product

1. Click on the Products tab
2. Click on the control button with the plus icon button to create a new product
3. Complete the required fields and any additional fields. Be sure to select the correct

options on the right column of the page
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4. From the control buttons, click the check icon to Save and for the additional options to
appear

5. Click on the Edit type-related options for the EULA , etc

6. Enter the desired text and if the EULA is required. When complete, click on the Save
and Close star from the control buttons to return to the Product page
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7. Click on the Save and Close star again to save and close the product

Creating a SKU

Click on the Products tab and then Click on the number under the SKUS (published) column.

Click the plus icon (+) to create a new SKU
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Enter a Title and Price.

Select the individual option created earlier for this specific SKU

Enter an override EULA or any additional product options

In the right column, select the desired options and select the SKU to be Published

Specify the download file. **See the section on uploading software files below. Be sure not to
include any spaces in, before, after the filename

From the control buttons click on the star icon to Save and Close
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Note: Clicking the number in the options column will display the list of all created options that
option group. New options may also be added from that page by clicking on the plus icon
control button.

Uploading Software Files

SFTP access only.  Please submit a support ticket to be granted access.

Restricting Products by I2A2 Characteristics

**Currently only for use with the Purdue Authentication plugin.

Setup:

1. Create appropriate access groups under the Members section for a one-to-one
relationship with an I2A2 characteristic.

2. Enable the "User - Purdue User Access" plugin.
3. Configure the plugin by pairing an I2A2 characteristic with an access group.
4. Save and close the plugin.

Configuring a product.

1. Edit a product from the Storefront
2. Select the access groups that you wish to have access to this product that are listed on

the right side of the page.  Selecting multiple checkbox combine the access groups via
OR.  Selecting an access group of "Students" and "Campus (W. Lafayette)" will allow
access to all students with Purdue credentials and everyone on the W. Lafayette
campus with Purdue credentials.

Direct SKU Linking

A direct link to a product SKU is available.  This link may be shared to allow someone quick
access to a specific item's description page.  The direct SKU link can be found when editing a
SKU in the info box on the top right of the page with a label of "Direct URL:".
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Entering list of serial keys for a product SKU

A single serial or multiple serial numbers (or License keys) can be added to be tracked as
inventory for a product SKU.

1. Edit a SKU
2. At the bottom right of the page find the "Serial numbers" section.
3. Select single or multiple.
4. Save the page.
5. A "Manage Multiple Serial numbers" button will appear.  You may enter serials number

via that interface or via CSV upload.

Notes:

The ability to enable to disable inventory tracking for the SKU is not available as tracking is
automatically and will deactivate serials numbers as they are distributed.

**A inventory notification threshold should also be set to be notified that an inventory of
available serial numbers are low.

Tracking Inventory of SKUs

Tracking or a count down of product SKUs is available.

1. Edit a SKU
2. On the right select the "Track Inventory:" to YES.  (if Serial Management is on, this

option will not be displayed)
3. Enter a value in "Inventory:" field. 
4. Enter a value in the "Inventory notification threshold:" field.

**To receive email notifications when an email address must be entered in the Cart component
option field of "Send notifications to".
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Restricting a list of usernames for a product SKU

A product SKU may be restricted by a specific list of username.

1. Edit a SKU.
2. Find the "Restrictions" section at the bottom right of the page.
3. Select "Restrict by users:" to YES.
4. Save the page.
5. A "Manage restrictions" button now appears.
6. Enter usernames via the Manage restrictions interface or via a CSV.

Notes.  Usernames must exist on the on hub before they can be added to the SKU restriction
list. A product access group must also be selected for the SKU's parent product to be able to
display in the collection list.

Download / Downloading limiting

The downloading of a SKU can be limited.

When editing a SKU, the "Total Downloads Limit:" will not allow user to download this SKU if the
number entered here has been exceed.  "Total Downloads" refers to all downloads by all users
for the SKU.

 

When editing a SKU, the "Downloads Limit per Single User:" will not allow a user to download
the SKU more than the number entered here.
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Support

Tickets

Users can create tickets when they experience a problem on the Hub that is not answered in
Questions and Answers or Knowledge Base. Tickets are ways to report bugs or issues that they
experienced with the Hub. Administrators are then able to access the Support component to
help solve these issues.

 

Answering Tickets

1. Navigate to https://yourhub.org/support and login to the hub
2. Access the Support and Ticket Tracking System
3. Select the tickets that are under the open tab on the side of the page
4. Select the ticket that has been unanswered
5. In the Comment Form, add tags to connect the ticket to search engines in the ticket

system
6. In the assignee dropdown select your name 

Note: You can only be an assignee if you have gained ACL access on the back-
end of the Hub.

7. Select the severity of the ticket. Critical and major are high priority tickets. Normal tickets
are common yet important tickets. Minor and Trivial tickets are low priority

8. Select the status of the ticket from the drop down. Open tickets are unanswered tickets; 
Awaiting User Action holds the ticket until they answer or respond. Closed tickets are
listed by the reason they are closed: Answered, Duplicate, Fixed, Invalid, Spam,
Transferred, Won’t fix, and Works for me

9. Answer or leave a canned response for the user that submitted the ticket. Canned
responses allow the assignee to respond using generic responses premade to fit various
situation such as: first response, second response, and closing ticket

10. In the bottom box CC any users or other assignees to the ticket to include in the
conversation on the ticket, then submit your response

 

Messages

To aid in responding to support ticket submissions, you may create custom message templates
for frequently used responses. Example responses include a Ticket resolved message sent
upon closing a ticket or a Request for more information message.

Messages may also include placeholders where information that changes can be specified. For
instance your message template may include references to the specific ticket ID number or site
name. A Ticket resolved template could look like this:
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“Thank you for using the (sitename), and for reporting this problem. We believe that your issue
(ticket#{ticket #} in our system) has been resolved. If you continue to have problems please let
us know.  You may reopen a closed issue at any time by following the link at the end of this
message and adding a comment to the ticket."

Thank you for helping us to improve (sitename)!

--the (sitename) team

Here we have two placeholders: {ticket#} and {sitename}. The placeholders are replaced with
their current value at the time of composition. When chosen from the select box under 
Comments of the response form, the comments text box will be filled with the following:

“Thank you for using the YourHUB, and for reporting this problem. We believe that your issue
(ticket #123 in our system) has been resolved. If you continue to have problems please let us
know. You may reopen a closed issue at any time by following the link at the end of this
message and adding a comment to the ticket."

Thank you for helping us to improve YourHUB!

--the YourHUB team

 

Resolutions

Resolutions give a report of how the ticket was solved once it is closed. For example if a ticket
was answered the resolution would be Answered or if the ticket was never answered because
the ticket owner did not respond with new information then the ticket could be closed with the
resolution Closed (No Answer). This system helps inform the support team or administrators
that search through closed tickets the necessary information on why the ticket was closed.

Open: unanswered ticket
Awaiting user action: waiting for user to respond
Closed: ticket has been answered or fixed
Answered: answered question of the user
Duplicate: the issue has already been reported
Fixed: the bug that was reported has been fixed
Invalid: this status is used for testing purposes and spam
Transferred: the issue was a enhancement request and moved to the wish list
Won’t fix: no solution to the issue
Works for me: the bug reported is not reoccurring for assignee of the ticket

 

Tags
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The tags allow tickets to be searched and tracked easily. Tags can also serve to inform the
support team about the problem without reading through the whole context of the ticket.

 

Stats

The stats page gives a basic overview of support ticket activity starting at the beginning of a
chosen year, defaulting to the current year if none is specified. Stats shown may also be filtered by

group.

The following data is shown:

Tickets opened for the given year
Tickets closed for the given year
Tickets opened for the current month of the year
Tickets closed for the current month of the year
Tickets opened for the current week of the year
Tickets closed for the current week of the year
Open tickets
Unassigned tickets
Average ticket lifetime
A list of administrators and the number of tickets closed

Closed for the given year
Closed for the current month of the year
Closed for the current week of the year

A line chart displaying Tickets Submitted (red) vs. Closed (green) on a monthly basis

Access Control Layer (ACL)

The ACL (Access Control Layer) works in conjunction with a user login system to allow or deny
a user access to support tickets and various information or features of a ticket.

Permissions may be set for individuals or entire groups of users. All members of a group will
inherit any permission set for the group. If a user is a member of multiple groups with ACL
settings, the highest permissions will take affect.

Individual ACL settings take precedence over any other settings.

 

ACL Options 
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1. Navigate to https://yourhub.org/administrator and log into the backend of the Hub
2. Click on the Components tab and then select the Support button from the drop-down
3. Inside of Support, click on Options to view details in the ticket submission process
4. There are three tabs that all define the parameters of tickets and available options for

the Hub ticket system
a. Defaults: displays the front page options when submitting and answering tickets
b. Files: controls the parameters of how documents and tickets are uploaded
c. Antispam: controls the words that can be used when submitting tickets to keep

spam out of the ticketing system
5. Click Save or Save & Close to allow the changes that were made in these tabs to be

saved on the Hub

 

Giving ACL Permission 

1. Navigate to https://yourhub.org/administrator and log into the backend of the Hub
2. Click on the Components tab and then select the Support button from the drop-down
3. Inside of Support, click on the ACL tab 
4. Under all of the available users that have permission for ACL access, there is a text box

to input alias or ID name
5. Input the name of the new ACL access, then select the sections that the user can have

control in
6. Click Add to confirm the new ACL access for the user 

Note: Super Administrators automatically receive ACL access and support
permissions.

Enabling Email Notification for Abuse Reports

1. Navigate to https: yourhub.org/administrator, and login as an administrative user on
the backend of the Hub

2. Click the Components tab and then select the Support button located in the drop-down
3. On the Support: Tickets page, select the Options button in the top-right corner of the

page
4. Select the Abuse Reports tab
5. Enable notifications to be sent when a report is created by selecting Yes from the drop-

down
6. Add the email address that the notification should be sent to by inserting it into the 

Notify when abuse report created box
7. Click the Save & Close button to save the changes and you will be navigated back to

the Support: Tickets page
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Enabling Privacy/Minimal Information Mode in Support Emails

Ticket content can be protected in emails by enabling privacy/minimal information mode to avoid
sending potentially sensitive data. This Support feature complies with FISMA and HIPAA
standards on restricting sensitive data.

In order to turn on this feature, follow these steps:

1. Navigate to the backend of the Hub and locate the Components tab
2. Click on the Components tab and from the drop-down click on Support
3. Inside of Support, locate the Options button
4. Locate Email Content and select from the drop-down the configuration of your choosing

1. Terse: Emails will only contain a notification that the ticket has been updated
and removes all sensitive information about the ticket.

2. Detailed: Emails will contain a notification that the ticket has been updated and
details about what was updated in the ticket

5. Click Save & Close to save the new changes
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Tags

Managing Tags

Tags are the Hub's way to highlighting and attaching key words to various content on the Hub.
Based off of hashtags, Tags allow users to connect various projects, groups, publications,
together by attaching the same tag to each piece of content. When creating or editing an area
on the Hub, you will be presented with a field to submit a tag.

You can simply add a tag by typing in the field a word and then click Enter. If you wish to
remove the tag, hover over the tag and an X will appear to the right of the word. Select the X 
and the tag will be removed.

How to Tag Tickets

Tags are essential in tracking tickets in the Support section of the Hub. Track various
component requests, broken sections and questions all by adding Tags to a ticket. For example,
when testing out a newly added feature or development item, you can tag your support tickets
with three tags conveying the information of where, what, and why. The following points define
each tag and have a list of examples under each point:

 

Where: The first tag should convey where the ticket is coming from.
Hub: Hub name
Development Environments: QA, dev, production

What: The second tag should convey what release the ticket involves.
Releases: The release number

Why: The third tag should convey why the ticket is being submitted.
Components: projects, collections, groups, super groups
Areas: backend, frontend, plugins, menus
Reasons: security, scripts,  hubupdate

Creating a Tag    

1. Log into /administrator interface of the Hub 
2. Hover over the Components tab and from the drop-down select Tags
3. Click on the New button
4. Check the box if the Tag will be viewable for administrators only or if the new Tag will

viewable by all users
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5. In the Tag text box write the Tag. Tags cannot have capitalized letters, non-
alphanumeric characters, spaces, or punctuation

6. In the Tag description box, write a detailed description of what the Tag represents
7. In the Alias box, write in a comma separated list the different Tags that the new Tag will

represent
8. Click Save & Close to save the new Tag

Deleting a Tag

1. Log into the /administrator of the Hub
2. Hover over the Components tab and from the drop-down and select Tags
3. Under the Tag tab, locate the tag that is to be deleted
4. Select the tab by checking the tag’s box
5. Once the tag has been selected, click Delete
6. The tag will be permanently removed from the Hub
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Usage

Overview

Hub usage statistics can be found on the /usage page. On this page the amount of user visits,
which calculates unique IP address visits identified by residence and organization as a graphic
along with downloads, also identified by IP address residence and organization. Tool simulation
users and jobs can be collected along with the total wall time, interaction time and CPU time.
Usage is collected each month and is a great resource to show community growth.

Usage Breakdown

Usage is a feature that gathers statistics about user registration, tool run, files downloaded and
more. 

The Usage breakdown can be divided up by these statistics:

Users - Visits: Amount of visits to the Hub and page hits by public visitors
Users - Downloads: Files downloaded by the user from Publications, Resources, Project
Files, etc.
Users - Residence: Location defined by a user's profile
Users - Organization: Organization defined by a user's profile
Simulation - Users: Total tool users running jobs on the Hub
Simulation - Simulation Jobs: Total tool jobs run on the Hub
Simulation - Total CPU Time: Total CPU time used
Simulation - Total Wall Time: Total wall time
Simulation - Total Interaction Time: Total time a tool jobs were interacted with
Simulation - Users with > 10 minutes of CPU Time: Users running more than 10 minutes
of CPU time
Simulation - Avg. Number of Simulation Jobs/User: Adverage number of simulation jobs
per user
Simulation - Avg. Time between First and Last Simulation: Adverage time between
simulations
Simulation - Repeat Users with > 10 Simulation Jobs: Users running more than 10 jobs
Simulation - Repeat Users with > 3 months: Users running jobs for more than 3 months

Usage Maps

The Usage Map provides an outlook on who is currently active and online through out the world.
This world view will add a location flag at the GPS location of that user. This location is defined
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by the address and location the user gives in their profile. By clicking on the location flag, one
can view the user's profile and location details.
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Wiki

Editing a Wiki Page

1. Log into the /administrator interface
2. Hover over the Components tab and from the drop-down select Wiki
3. Locate the wiki page that is to be edited
4. Click on the title of the wiki to open it up
5. Edit the wiki form then click Save & Close to save the changes 

Deleting a Wiki Page

1. Log into the /administrator interface
2. Hover over the Components tab and from the drop-down select Wiki
3. Locate the wiki page that is to be deleted
4. Check the box beside the wiki title
5. Click Delete to deleted the wiki page
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Wishlist

Terminology of Wishes

Active- open wishes where people can vote on the wish
Accepted- the wish has been accepted and will be activated
Rejected- the wish will be denied for now
Granted- the wish is already available or will be in the next update
Like- voting up the wish
Dislike- voting down the wish

Creating a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Click the New button
4. Fill out the wish form
5. Click Save & Close

Editing a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Search for the wish and then click on the wish's title
4. Click the Edit button
5. Edit the wish form
6. Click Save & Close

Deleting a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Search and then click on the title of the wish
4. Click the Delete button and the wish will be deleted
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Publishing a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Search and then check the box by the wish's title
4. Click the Publish button and the wish will be published

Unpublishing a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Search and then check the box by the wish's title
4. Click the Unpublish button and the wish will be published
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Newsletters

Overview

Newsletters is a component where Hub Administrators and Managers can create and send
newsletters to your Hub's community, either sharing big news or the latest published resource.
Newsletters offers Administrators and Managers the option to create a template for the
newsletter copy, the opportunity to create a mailing list to send the newsletter to individuals
outside of the Hub, and the ability to schedule a newsletter to be sent out at a later date.

Displaying Newsletters on the Hub

1. Log in to the backend of the Hub and navigate to the Components tab and then click 
Newsletters

2. Locate the newsletter that is to be published to the Hub, and then select the newsletter
3. Click Edit to open up the newsletter and inside the Newsletter Details go to Show

Newsletter on HUB
4. Choose from the drop-down Show to publish the newsletter to show on the frontend of

the Hub
5. Click Save & Close to save the new changes

Creating a Newsletter Template

1. Log in to the backend of the Hub and access the Components tab and then click on 
Newsletters

2. Select the Templates tab and then click New to start a new template
3. Type in the name of the new template
4. Insert the primary title color, primary text color, secondary title color, secondary text

color
a. The colors are in HTML format. To find more colors and the related HTML codes,

go here: http://html-color-codes.info.
b. Note: If you don’t fill in HTML colors, black and gray default colors will be used.

5. Fill in the design by using HTML formatting to the template
a. Use the suggestions on the side of the page to add content to the template.

6. Click Save & Close to save the new template design

Editing a Newsletter Template
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1. Log in to the backend of the Hub and access the Components tab and then click on 
Newsletters

2. Select the Templates Tab and then check the box to select the template that needs
editing

3. Click Edit to begin editing the material
4. Click Save & Close to save the newly edited content

Deleting a Newsletter Template

1. Log in to the backend of the Hub and access the Components tab and then click on 
Newsletters

2. Check the box to select the template that is going to be deleted
3. Click Delete to permanently delete the template
4. The template will then be removed from the Hub

Creating a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. Click on New to create a new Newsletter to send out to your users about new updates
or news that is happening for the Hub

3. Under Newsletter Details fill in the title of the Newsletter or Name and the alias, what
appears in the URL, of the Newsletter

4. Fill in the issue number of the Newsletter
5. From the drop-down decide what email format the Newsletter will be sent in

a. HTML: The Newsletter will be formatted with HTML coding. HTML emails will
also auto build a plain text version to send along with the HTML version. This is
primarily for avoiding being marked a spammer.

b. Plain Text: The Newsletter will be formatted with plain text and no coding.
6. Select the template of the Newsletter
7. Select from the drop-down if the Newsletter is to show on the Hub right away

a. You may want to hide private email newsletters or plain text email newsletters
from showing on the Hub.

8. Select from the drop-down if the Newsletter is to track the emails
a. Learn more about email tracking here: http://kb.mailchimp.com/article/about-

open-tracking
9. Click Save to save the new changes and to add to the Newsletter the content

10. Add the Newsletter Mailing Details
11. Insert the main content of the Newsletter in the Newsletter Primary Stories

a. Title: Title of the article
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b. Order: Order of the Issue
c. Story: Content of the Newsletter

12. Insert the Newsletter Secondary Stories for content in the sidebar of the Newsletter.
Fill in the same sections of content as the primary stories

13. Click Save & Close to save all of the content and to finish the new completed
Newsletter

Editing a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. On Newsletter main page, select the box beside the Newsletter that is going to be edited
3. Click Edit to begin editing the Newsletter
4. Click Save & Close to save the newly edited content

Deleting a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. On the Newsletter main page, select the box beside the Newsletter that is going to be
deleted

3. Click Delete to permanently delete the Newsletter from the Hub

Copying a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. On the Newsletter main page, select the box beside the Newsletter that is going to be
copied

3. Click Copy to copy the Newsletter selected
4. The Newsletter and all its stories or content will be copied

Default Mailing List
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There is a default mailing list of every user who has agreed to receive emails from the Hub. This
mailing list is updated with new users who have modified their settings or who have been
blocked every time a new mailing is created. To send a newsletter to the default mailing list,
follow these steps:

1. Navigate to the /administrator interface
2. Hover over Components and from the drop-down select Newsletter
3. Click the checkbox next to the newsletter you wish to send
4. Click the Send button in the toolbar
5. Select the Default mailing list and determine the time when you want the newsletter to

be sent
6. Click the Send button in the toolbar and your newsletter will be sent to the users who

opted in at the time you selected

Creating a Mailing List

1. Log in to the backend of the Hub
2. Navigate to the Components tab and click on Newsletters
3. Under the Newsletters, click the Lists tab
4. Click the New button to start a creating a new mailing list
5. Fill in the name of the mailing list, and then choose if the mailing list is going to be

private or public
a. Private: Must be invited to join list.
b. Public: All Hub visitors can view the mailing list and can choose to join the

mailing list.
6. Fill in the description describing the purpose of this mailing list and indicate what types

of mailings this list will receive
7. Click Save & Close to save the basic details of the mailing list

Adding Emails to a Newsletter Mailing List

1.  Log in to the backend of the Hub
2. Navigate to the Components tab and click on Newsletters
3. Under the Newsletters, click the Lists tab
4. Select the mailing list that you would like to add emails to, then click the Manage button

(person icon) in the top right
5. Inside the list, click Add Emails to add emails to the mailing list
6. Determine if the user will be prompt into confirming the email or not having to confirm

the email
7. If all the emails are stored in an Excel file, upload the file and all the emails inside will be
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added to the list, or select the group from the Hub to add their emails to the mailing list
8. If any extra emails need to be added to the mailing list, manually enter them into the 

Enter Emails Here text box. Leave a comma after each email
9. Save the content by clicking Submit

Mailing Statistics Overview

1. Log in to the backend of the Hub and navigate to the Components tab and then click 
Newsletter

2. Select the Mailings tab in the Newsletter component
3. Select the newsletter the previously submitted mailings and then click Stats to access

the statistical report collected from the mailing
4. Inside the mailing statistics, you can view the follow details:

a. Open Rate: The percentage and total of viewers out of how many emails sent
out.

b. Bounce Rate: The percentage of emails that bounced back, thus the user did
not receive the email.

c. Forwards: The number of times viewers forwarded the Newsletter.
d. Prints: The number of times viewers printed off the Newsletter.
e. Top Locations: The top countries with the most Newsletter viewers.
f. World Map: A total count for each country highlighted on a global map of

Newsletter viewers. Hover over each country to view the number of who opened
the Newsletter.

g. Click throughs: The number of times views clicked a link in the Newsletter.

Publishing a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. Under the Newsletters tab, select the box beside the Newsletter that is going to be
published

3. Click Publish to publish the Newsletter
4. The Newsletter will appear on the frontend for all users to see

Un-publishing a Newsletter
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1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. Under the Newsletters tab, select the box beside the Newsletter that is going to be
unpublished

3. Click Unpublish to unpublish the newsletter
4. The Newsletter will then be unpublished from the Hub
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Knowledge Base

What is the knowledge base?

The knowledge base houses helpful articles and frequently asked questions. Hub managers
can add their own hub specific articles to help their community understand how to use the
features.

 

Creating Knowledge Base Articles

1. Navigate to the Knowledge Base under the Component tab
2. Select the tab Articles
3. Select New to create a new article
4. Select the category or sub category where the article will be located
5. Fill in the title, URL alias, the body containing the article, and tags to connect the article

for easy search
6. Under State, select if the article is to be published to the Hub and the access level from

the dropdown
7. Select the parameters on what sections of the article that the users can view
8. Select the Save & Close to save the new article
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GeoSearch

How to Activate GeoSearch

GeoSearch is a component that allows users to view other members, organizations, events, and
even job postings on one map. Users can scroll over each pin and click a link to view the pin in
more detail.

 

1. Log into the administrator side of the Hub
2. Go to Extensions and click Plugin Manager from the drop-down
3. In the Plugin Manager search for CRON - GeoSearch
4. Open the plugin and then enable the plugin
5. Click Save & Close to save this change
6. In the Plugin Manager search for Geocode – Google Maps
7. Enable this plugin before moving on to the next step
8. Navigate back to the main page of the administrative side of the Hub
9. Go to Components and select CRON from the drop-down

10. Inside of the component CRON, click the Add button in the upper right hand corner of
the screen

11. Select the Event of the new CRON job to be Cron-Geosearch: Get Location Data
From Sources from the drop-down and then add the name of the new CRON job to
match the name of the event

12. Select the Frequency of the job to be Once a day, midnight
a. This is suggested to prevent overrunning Google Maps API request limit.

13. To save this new job, click Save & Close
14. Enable the new CRON job and then manually Run the job
15. Navigate to the GeoSearch main page and refresh the page
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Billboards

Overview

Billboards is a component that allows you to create a carousel effect on your home page. Slides
can be designed with an image in the background and a short piece of text that goes over the
image. Many use this feature to promote Super Groups or popular Tools.

Uploading an Image
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1. To upload an image, open the Billboard you would like to edit 
2. Click Upload Image, located underneath the Background Image field 
3. Click the Browse button located on the bottom of the Media Manager pop-up, and

locate  and select the picture you would like to upload 
4. Click Start Upload. You should then see your picture appear as an option
5. Copy the file name and paste it into the Background Image field
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Blogs

Backend Blog Manager Overview

Published - this icon means that the blog post can be viewed on the frontend of the
hub.
Unpublished - this icon means that the blog post cannot be viewed on the frontend of
the hub.
New - this button allows you to create a new blog post.
Edit - this button allows you to make changes to a blog post.
Delete - this button allows you to delete a blog post.

Creating a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. On the Blog Manager, click the New (+) button in the top right to create a new blog post
3. In the details of the blog post, select the scope. The scope is the location of the blog

either on the site, member, or group. If you're creating a group blog, select the group
that the blog should belong to from the drop-down

4. Fill in at least the title and content for the blog post
5. In the publishing options of the blog post, select the state of publishing from the drop-

down, the dates of when the blog is available, and if you would like to allow comments
on the post, check the box for Allow comments

6. Click Save & Close

Editing a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. Find the blog post you would like to edit and click on its title to open the post
3. Edit the content of the post
4. Click Save & Close to save the newly edited content

Deleting a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. Find the blog post you would like to delete and click on the check box for that blog post
3. Click on the Delete button symbolized by a trashcan and the blog post will be deleted
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Publishing a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. On the Blog Manager, select the location of the blog post from the following tabs: site,

members, or groups
3. Find the unpublished blog post you would like to publish and click on the checkbox next

to it to select it
4. Click Publish and the selected blog post will be visible to users

Unpublishing a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. On the Blog Manager, select the location of the blog post from the following tabs:

site 
members
groups

3. Find the published blog post you would like to unpublish and click on the checkbox next
to it to select it

4. Click Unpublish and the selected blog post will be no longer be viewable on the front-
end

                            69 / 94



COMPONENTS
 

Cart

Overview

All actions listed here take place in the administrator interface of the hub, similar to 
https://hubname.org/administrator. Proper administrator privileges and logging in are required.

 

Cart component can be found by:

1. Log into the administrator interface (/administrator)
2. From the Main Menu point the mouse to Components -> Cart

Receiving notfications

In the Cart component options, enter a email address or a comma separated list of emails to the
"Send notifications to " configuration option to receive email notifications.

Software Downloads - All Downloads

Product, Downloaded by, User Info, EULA, Downloaded date, IP, and Status can be viewed.  A
CSV can also be downloaded.

 

A SKU's status may be manually updated to "inactive" if another "active" download of that SKU
needs to be made available.  This only apply when limitations are configured for downloads. 
For example, if a user is only allow to download a SKU once, but report that there was an issue
with the download an administrator may make the previous download as inactive to allow for
another download of that SKU.

 

History is retained for each record in this report.  If a user changes status, the new status will
not be updated in previous download records.
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Software Downloads - SKU

Product and Downloaded count can be viewed.  A CSV can also be downloaded.

Orders - All orders

Order ID,  Order total, Items ordered, Order placed date, and Purchased by, can be viewed.  A
CSV can also be downloaded.

Orders Items ordered

SKU ID, Product Decription, QTY, Price, Order ID ,Order placed date, and  Purchased by may
be viewed.  A CSV may also be downloaded.
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Citations

Deleting a Citation

1. In the backend, navigate to Citations under the Components tab
2. Find the citation to be deleted, and click on the check box for that citation
3. Click on the Delete icon on the top of the page and the selected citation will be deleted
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Collections

Module for Collecting

The hub comes with a module, mod_collect, for collecting a number of content types on the
hub: resources, wiki pages, forum threads, courses, publications, and content articles. This
module can be enabled via the administrative Module Manager. Once the module is enabled, a 
Collect button will appear on the single view pages for the various types of content. Users can
then collect resources, wiki pages, etc. The collected material will be saved as a post with a link
back to the original content.

Collectible content types:

To enable the module:

Wiki pages
Forum threads
Courses
Resources
Publications

1. Navigate to https://yourhub.org/administrator/ and login as an administrative
user

2. In the backend, under the Extensions tab, select Module Manager
3. Find the module, and then select the module by clicking the small check box
4. Once the module has been selected, click Enable to enable the module
5. The module will now be active on the hub and users will be able to collect

content for collections

Editing Collection Items

Note: You have to be logged into your hub in order to complete the following tasks

1. Navigate to https://yourhub.org/administrator/
2. Locate the Components tab and then select the Collections button located in the drop-

down
3. On the Collection page, click the Items tab
4. Locate the item and then check the box beside the title of the item
5. Click the Edit button to edit the item
6. Make the changes to the item and then click Save & Close to save the changes and

you will be navigated back to the Collection: Items page

                            73 / 94



COMPONENTS
 

Courses

Creating a Course

1. On the /administrator interface, navigate to Courses under the Components tab
2. At the top of the Courses panel, click the + sign to add a new course
3. Fill in the details of the course. (See below for field/option descriptions.)
4. Click on the drop-down section under Publishing, and determine if you want your

course to be a Draft or Published
5. Click on Save to save the work that you have completed. You can only further edit your

course, such as add an image or managers, after you have saved the initial details
6. Under the Managers area, add course administrators (Instructors, Managers, etc.)
7. Under the Image area, add a course image by dragging an image file into the upload

box
8. Click Save & Close to save all the details of the course and to go back to the Courses

main page, where your course will now be listed

 

Field/Option Descriptions

Course Alias: Your course alias. This will be part of the URL.
Course Title: The official name of your course. This name will be what users see when
browsing the hub.
Interests (tags): Helps categorize your course in search results. These tags can help
your course be discovered more effectually.
Blurb: A short description of the course.
Description: A longer description of the course. Here you can personalize what the goal
or concept is in further detail to your students.
Unpublished: The course is taken off the front end of the hub.
Published: The course can be found in the front end. Anyone can find the course
through searches.
Draft: The course is being drafted. The course is accessible only to course
administrators. This allows instructors and managers to build a course before it is
available to students.
Deleted: The course is deleted permanently. Once a course is deleted nothing can be
retrieved from the course after this action.

Creating Course Overview Pages (tabs)

1. In the backend, navigate to Courses under the Components tab
2. Find your course in the list. Under the Pages column, click on the + sign to add a new
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page 

Note: If there are already existing pages, you will see a number in place of the + sign.

3. Enter the title, URL, and content into the page details. In the published parameters
choose Yes to make the page active on the Course Overview 

Note: Note: A new page must be saved before files can be uploaded.

4. Click Save & Close and your new page will appear in the course pages list in the
backend. On the frontend, your new page will show as another tab in the Course
Overview

Opening up Enrollment into a Course

1. In the backend, navigate to Courses under the Components tab
2. Locate the course and click the number of offerings for that course in the 

Offerings column
3. Locate the offering and click the number of sections for that offering in the 

Sections column
4. Click the section’s title
5. Under the Details tab, locate Enrollment and select a response from the drop-down

a. Open (anyone can join): Any user on the Hub can join this section of the
course.

b. Restricted (coupon code is required): Only users with a coupon code can gain
access to this section of the course.

c. Closed (no new enrollment): This section of the course is closed and cannot be
accessed by new students.

Editing Parameters in an Offering

1. In the backend, navigate to Courses under the Components tab
2. Locate the course and click the number of offerings for that course in the 

Offerings column
3. Locate the offering and click the title
4. Locate the Parameters section and select the parameters for Progress Calculation

Inherit from course defaults- means that all of the parameters preset on the
hub will be the same for this offering.

5. Click Save & Close to save the parameters for that offering
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Editing Parameters in a Section

1. In the backend, navigate to Courses under the Components tab
2. Locate the course and click the number of offerings for that course in the 

Offerings column
3. Locate the offering and click the number pf sections for that offering in the 

Sections column
4. Click the section's title
5. Under the Details tab, locate the Parameters section and select the parameters for 

Progress Calculation
Inherit from course defaults- means that all of the parameters preset on the
hub will be the same for this section.

6. Click Save & Close to save the parameters for that section

 

Editing Discussion Parameters

1. In the backend, navigate to Courses under the Components tab
2. Find the course and the click the number in the Offerings column
3. Locate the offering and click the number of sections for that offering in the 

Sections column
4. Click the title of the section that you would like to change the discussions settings in
5. Under the Details tab, locate the Discussions Parameters area. In the drop-down,

choose All sections to show discussion threads across all sections in this offering, or
choose This section only to show discussion threads only by this specific section

6. Click Save & Close to save the changes to the parameters

Deleting Assets

Note: You must be logged into your hub in order to complete the following tasks.

 

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, locate the course
3. After locating the course, under the Offerings column, select the number of offerings
4. On the Courses: Offerings page, locate the offering
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5. Locate the Units column and select the number of units
6. Locate the Unit, then under the Asset Groups column select the number of under the

column
7. Inside Asset Groups, check the box of the offering
8. Click the Delete button to permanently remove the content and asset from the course
9. A pop-up will appear asking Are you sure you want to remove these items?

10. Proceed to click OK, and the items will be removed from the course

Creating Certificates

Note: You must be logged into your hub in order to complete the following tasks.

 

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, locate the course
3. After locating the course, under the Cert. or certificate column click on the No

Certificate Set button
4. On the Courses: Certificate: Create page, upload a PDF certificate file by choosing the
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file from your files and then clicking Upload
5. Once the file is uploaded, a preview will appear

a. The preview is where you can place, drag, and resize various placeholders for
elements such as the user’s name, course name, etc. to be dynamically filled in
when a certificate is claimed.

6.  Click the Save & Close button in order to navigate back to the Courses page

Deleting Certificates

Note: You must be logged into your hub in order to complete the following tasks

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, locate the course
3. After locating the course, under the Cert. or certificate column click on the Certificate

Set button (checkmark icon ?)
4. On the Courses: Certificate: Create page, click the Delete button

5. Click the Save & Close button in order to navigate back to the Courses page
6. A pop-up will appear stating Entry successfully removed and you will be navigated

back to the Courses page

Changing Deployment Time

Note: You must be logged into your hub in order to complete the following tasks.

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, locate the course
3. After locating the course, under the Offerings column, select the number of offerings
4. On the Courses: Offerings page, locate the offering
5. Locate the Sections column and select the number under the column
6. Check the box of the section, and then click the Edit button
7. In the Courses: Sections: Edit page, select the Dates/Times tab
8. Locate the course asset and set a date and time for the content of the asset, which is

usually in the third tier inside the asset group
a. Example: Exam> Exam 1> Exam1

9. Set the date and time by clicking the From and To boxes to access the time pop-up
10. Save the changes by clicking Save & Close and a pop-up will appear saying Entry

successfully saved
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Display Number of Users Enrolled in a Course

Note: You must be logged into your hub in order to complete the following tasks.

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, select the Options button in the top-right corner of the page
3. Under the Defaults tab, locate the Show Enrollment Numbers option at the bottom of

the pop-up
4. Select between Yes to show enrollment numbers or No to not show enrollment numbers

from the drop-down
5. Click the Save & Close button to save the new setting and exit out of the pop-up

Course Presentations: HUB Presenter

Hub Presenter is a presentation formatting section available to upload large video files inside of
Courses. An administrator with privileges to workspace is the only one who can upload these
presentation files. 

1. Navigate to the HUB and go to hubname.org/resources
2. Create a new Resources and make the category Online Presentations
3. Fill out the information needed for the Resource and then navigate to the backend of the

HUB to make sure that the Resource is Published
4. Then, navigate to the HUB Workspace and ssh into your HUB account
5. Upload the videos & slides of the presentation

1. Note: Slides must be uploaded in order by appearance as individual images
(.jpg) in a zipped folder called Slides, the video must be uploaded as a .webm,
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.mp4, and a .ogv
1. Example:  media.webm/media.mp4/media.ogv

6. Create a folder called /slides and then navigate to /hubname/app/site/resources/XX-XX-
XXXX/slides and upload all image slides as a .zip file 

1. Note: "XX-XX-XXXX" is the date of when the resource was created
7. Listed below is an example of the presentation layout:

{
    "presentation": {
        "title": "Career Development",
        "type": "Video",
        "media": [
            {
                "source": "media.mp4",
                "type": "mp4"
            },
            {
                "source": "media.webm",
                "type": "webm"
            },
            {
                "source": "media.ogv",
                "type": "ogv"
            }
        ],
        "slides": [
            {
                "title": "Career Development",
                "type": "Image",
                "media": "slides/001.01.jpg",
                "time": "0",
                "slide": "1"
            },
            {
                "title": "Career Development",
                "type": "Image",
                "media": "slides/001.01.jpg",
                "thumb": "slides/001.01.jpg",
                "time": "8.5752419085752418",
                "slide": "1"
            },
            {
                "title": "Your Career Choices after Graduate School and The Most-Neglected Item in
your Career Development",
                "type": "Image",
                "media": "slides/002.01.jpg",
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                "thumb": "slides/002.02.jpg",
                "time": "50.417083750417085",
                "slide": "2"
            },
            {
                "title": "Your Career Choices after Graduate School and The Most-Neglected Item in
your Career Development",
                "type": "Image",
                "media": "slides/002.02.jpg",
                "time": "64.7313980647314",
                "slide": "2"
            },
            {
                "title": "Questions? I Might have replies….",
                "type": "Image",
                "media": "slides/046.01.jpg",
                "thumb": "slides/046.01.jpg",
                "time": "4506.6733400066732",
                "slide": "46"
            }
        ]
    }
}

 

?

Setting a Course in Preview Mode

You can set a course offering to give users a preview from the administrator interface.

1. Navigate to /administrator for your hub and login
2. Click on "Courses" under "Components"
3. Locate the course where you want to enable preview mode, and click on the number of

offerings
4. Then click on "Sections" for that offering
5. Click on the title of the offering
6. Under "Parameters" change "Preview mode" to "Yes, offer a full preview" or "Yes, offer a

preview of the first unit."
7. Click "Save & Close"
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Cron

Cron Jobs

A complete list of available Cron jobs that can be set up that work with other components and
sections of a Hub.

 

Cron- Activity: Cron events for activity feed. Sends email digests at designated intervals to
users containing their recent activity on the Hub.

Cron – Cache Handler: Cron events for Hub cache. Removes old system CSS files and
trashes expired cache data at designated intervals.

Cron – Courses: Cron events for courses. Runs a specific job(s) at a set interval linked to the
Courses component. Syncs passport badge statuses and can email instructors with a digested
update at designated intervals.

Cron – Forum:  Cron events for forums. Runs a specific job(s) at a set interval linked to the
Forum component. Sends group forum email digests at designated intervals.

Cron – Groups: Cron events for groups. Runs a specific job(s) at a set interval linked to the
Hub groups. Can remove group asset folders that were abandoned and send group
announcements at intervals.

Cron – Members: Cron events for members. Runs a specific job(s) at a set interval linked to the
Hub members. Can calculate point royalties.

Cron – Newsletter: Newsletter: Cron events for newsletter. Runs a specific job(s) at a set
interval linked to the Newsletter component related to mailing out newsletters. Can process any
newsletter mailings in the queue and process IP addresses to location data for newsletter email
actions.

Cron – Publications: Cron events for publications. Runs a specific job(s) at a set interval linked
to the Publications component. Set to email monthly publication stats to authors, compute
unique user stats from text logs, issue master DOI and achieve publications (via mkAIP) when
grace period expired – PURR ONLY.

Cron – Resources: Cron events for resources. Runs a specific job(s) at a set interval linked to
the Resources component. Issues master DOI and audit resource data.

Cron – Search: Cron events for Search. Runs a specific job(s) at a set interval linked to the
Search component. Set to process queues at set intervals.
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Cron – Support: Cron events for support. Runs a specific job(s) at a set interval linked to the
Support component that processes the support queue based on predetermined parameters.
Has the ability to close tickets, email reminders for open tickets, email for tickets with specified
parameters and remove temporary upload files and directories at set intervals.

Manually Running a Cron Job

1. Log into the /administrator interface 
2. Hover over the Components tab and from the drop-down select Cron 
3. Search for the cron job and check the box beside the cron job's title
4. Select the Run icon on the top of the Cron main page
5. The Cron job will automatically run the predetermined job

Deleting a Cron Job

1. Log into the /administrator interface 
2. Hover over the Components tab and from the drop-down select Cron 
3. Search for the cron job and check the box beside the cron job's title
4. Select the Delete icon on the top of the Cron main page
5. The Cron job will be deleted
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Events

What is an event?

Do you have an upcoming event that you would like to share with other hub users? The Events
component allows you to submit the details of these events and share them with your
community.

Note: Administrators must first log in to the backend of the hub in order to complete the tasks
below.

Creating an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, select the New icon
3. Fill in the title of the event
4. Select the category of the event

General: an event is the broadest category for events.
Workshop: is an event that is a clinic for users.
Seminar: is an event that hosts a speaker or presentation.
Meeting: is an event similar to conferences.

5. Add a description in the Activity field that includes details about the event and include
whom the event is intended for

6. Fill in the location of the event, the website/URL that pertains to the event or where
event information is stored, and add tags to connect the event to tag topics

7. Set the date and time of the event using the drop down calendar from the boxes. An
event can last multiple dates as an expanded time frame. The time span of the event is
calculated in military time

8. Select the time zone that the event is held in for this helps set up the time frame of the
event for users in different time zones

9. If the event has registration, fill in the information in the registration section
Select Register by date
Enter contact email address. This is the email address to which registration
forms will be sent
 If registration is restricted for the event (Invite Only), enter a password users
must enter to gain access to the registration form into the Restricted field
To choose certain registration fields for your event, select the Hide or Show
icons by clicking on the radio buttons in the Registration Fields area

    10. Click Save to add the event to the Hub calendar. The event will be automatically
published and will appear on the frontend
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Editing an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, locate the event that needs editing, and click the select the
checkbox next to it

3. Once the event has been selected, click on Edit icon to edit the content of an event
4. Fill in the Event details, and then click Save & Close to save the changes

Deleting an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, locate the event that needs editing, and click the select the
checkbox next to it

3. Once the event has been selected, click the Delete icon. The event will be permanently
removed from the Hub

Unpublishing an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, locate the event that needs to be unpublished
3. In the State column, a green check mark icon indicates the event is currently published
4. Click the green check mark icon in the state column of the event you’d like to unpublish
5. The state column will now show a circle with a line through it icon, indicating that it has

been unpublished

Viewing Event Respondents

If registration was set up for an event, a hub administrator can view the registrant information by
logging into the backend.
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1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, find the event, and select the check box next to it
3. Once the event has been selected, click on View Respondents button in the upper right

4. Now all of the respondents to the Event can be viewed along with information that they
filled out when they registered for the event

Adding a Page to an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. On the Events Manager, click the Events tab and select the box of the event you are
editing

3. Once the event has been selected, click on Add a Page (plus icon +)
4. Add the details of the page for the event. Here extra information can be added to the

event, including details of the event and key information for the participants
5. Click Save & Close to save the new page to the event
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Feed Aggregator

What is the feed aggregator?

The Feed Aggregator is a component which allows feed managers to collect articles from
several RSS feeds and to selectively combine them into one site-sponsored RSS feed.

 Users must also be logged into the hub to see any of these controls.

Adding a Feed Manager

In order to access the feed controls, a user must be added as a feed manager.

The feed aggregator controls are only available to those given either the Author, Editor, or
Published role. Users must also be logged into the hub to see any of these controls.

1. Click on Users Menu and select Members
2. Check the box next to the user whom shall be promoted
3. In the drop-down, select the permission level as Author, Editor, or Publisher, for the user
4. Once the group has been selected, click save and close to save the changes
5. The user will now have access to sort posts from the feeds

Adding a Feed URL (RSS)

1. Navigate to the URL https://yourhubname.org/feedaggregator
2. Click the Add Feed button in the upper right hand corner of the page
3. Add the Feed Name, the Feed URL, and enter the description of the feed
4. Click the Submit button to add the feed to the source feed collection

Retrieving and Managing Posts

1. Navigate to the URL https://yourhubname.org/feedaggregator
2. Click the Retrieve New Posts button to pull new posts from the URLs that have been

added to the Feed Aggregator. New posts will be added to the list
3. Once new posts have been added to the list, manage the new posts by selecting

approve, mark for review, or remove
1. Approve - Add the post to the generated feed.
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2. Review - Allow other managers to review the post before adding it to the
generated feed.

3. Remove - Remove the post permanently from the collect posts.
4. Once a selection has been made from the three options the choice that was made the

button will turn gray
5. To change the selection, click one of the other options

Accessing the Feed URL

1. Navigate to https://yourhubname.org/feedaggregator
2. To view the feed URL, click on the Generate RSS Feed button
3. The aggregator link will be generated into a pop-up box with a blue highlighted link
4. Copy the link into any readers that accept RSS feeds as input

Disabling a Feed

 

1. Navigate to https://yourhubname.org/feedaggregator
2. Click the View Feeds button
3. Locate the feed that is to be disabled
4. Click the Disable button.  It will then be disabled, and new posts will no longer be

retrieved from the feed and added to the feed aggregator

Enabling a Feed

1. Navigate to https://yourhubname.org/feedaggregator
2. Click the View Feeds button
3. Locate the feed that is to be enabled
4. Click the Enable button.  Any new posts will be retrieved from the feed and added to the

feed aggregator

Editing a Feed
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1. Navigate to https://yourhubname.org/feedaggregator
2. Click the View Feeds button
3. Locate the feed to be edited, and click the feed’s Edit button
4. Edit the content of the feed, and then click Submit
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Forum

What is a Forum?

A forum, or message board, is an online discussion area where people can hold conversations
in the form of posted messages.

Forums have a specific set of jargon associated with them; e.g. a single conversation is called a
thread or discussion.

A discussion forum is hierarchical or tree-like in structure: a forum can contain a number of
sections, each of which may have several categories. Within a forum's category, each new
discussion started is called a thread, and can be replied to by as many people as so wish.

 

What is a section?

Sections are a way to organize or group related categories (topics). By default, sections are
sequenced alphabetically by title.

 

What is a category?

Forum categories are a simple way to group related threads or discussions together. When a
category is locked, no new threads may be created within that category. Typically, a locked
category will be indicated as such by a padlock icon.

 

What is a thread?

A thread (sometimes called a discussion) is a collection of posts displayed from oldest to latest.
A thread is defined by a title, an additional description that may summarize the intended
discussion, and an opening or original post (common abbreviation OP, which can also mean
original poster), which opens whatever dialogue or makes whatever announcement the poster
wished. A thread can contain any number of posts, including multiple posts from the same
members, even if they are one after the other.

Note: Users must be logged in to the hub in order to participate in the forum.
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Creating a Category

1. Navigate to the Component tab and click on Forum
2. On the Forum component, select the Category tab and then click on the New button on

the top of the page
3. Fill in the title of the new category
4. Fill in the alias or title that will be displayed in the URL
5. Fill in the scope or site and the scope ID or site identification number for the new

category
6. Select the state of publish from the drop-down

a. Unpublished: The category will be removed from the frontend Hub but available
on the backend of the Hub.

b. Published: The category will be available of the frontend and backend of the
Hub.

c. Trashed: The category will be removed from the Hub.
7. Select the access level from the drop-down

a. Public: All visitors or users of the Hub can access the category.
b. Registered: Only registered users of the Hub can access the category.
c. Special: Only registered users with special permissions can access the

category.
d. Protected: Only users with protected rights can access the category.
e. Private: No users besides the creator of the category can access the category.

8. The Category can be locked so that no new posts will be allowed by checking the box in
Details

9. Click Save & Close to save the new section and to return to the Forum dashboard

Creating a Section

1. Navigate to the Component tab and click on Forum
2. On the Forum component, select the Section tab and then click on the New button on

the top of the page
3. Fill in the title, alias (URL ending), scope (site), and scope ID for the new section
4. Select the state of publish (unpublished, published, or trashed) from the drop down and

the access level (public, registered, special, protected, or private)
5. Click Save to remain on the Forum: New Section edit page or click the Save &

Close to save the new section and to return to the Forum dashboard
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Creating a Discussion Thread

1. Navigate to the Component tab and click on Forum
2. In the Forum component, select Threads
3. Click the New icon
4. Fill in the title, alias (URL ending), scope (site), and scope ID for the new section
5. Select the state of publish (unpublished, published, or trashed) from the drop down and

the access level (public, registered, special, protected, or private)
6. Click Save to create the thread

Deleting a Discussion Post

1. Navigate to the Component tab and click on Forum
2. In the Forum component, find and select the Forum thread post to be edited by clicking

the Delete icon
3. The forum post will be automatically deleted and saved. Once a post is deleted, the

material cannot be retrieved

Limiting Thread Viewing Access

(Note: You have to be logged into your hub in order to complete the following tasks)

1. Click the Components tab and then select the Forum button located in the drop-down
2. On the Forum page, click the Threads tab
3. Select the title of the thread and then click the discussion post’s title
4. Under the Publishing Options, selecting from the drop-down can change the 

Access of the discussion thread
a. Public: All users or visitors to the Hub can view the discussion thread
b. Registered: Only logged in users can view the discussion thread
c. Private: Only certain members have access to the discussion thread

5. Save these changes by clicking the Save & Close button
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Tools

Managing Tools

While Tools can only be managed through the tool pipeline,  tool sessions can be managed on
the backend in the /administrator interface.

Managing the Maximum Open Tool Sessions per User

User session limits (and tool preferences) can be found by following these steps:

1. Navigate to /administrator interface
2. Hover over Components and from the drop-down select Tools
3. Click on User Preferences
4. Number of sessions is dictated by the session class

1. Default Class = 3
1. Add another class by clicking "Custom" class, then enter the number for

the user
5. If a user doesn't have an entry, you can create one for them
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